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Управление из Excel через COM порт 

 

Цель работы: Изучить технологии обмена данными через COM порт при помощи средств 
ActiveX 

Задача работы: Построение канала связи “Excel – объект” для целей управления. 

Приборы и принадлежности: Два персональных компьютера, Microsoft Excel, COM Port 
Toolkit, элемент ActiveX MSCOMM32.OCX , нуль-модемный кабель, адаптер MOXA UPort 
1150, Модуль дискретного ввода-вывода ОВЕН МК110, датчик температуры с частотным 
выходом MAX6577. 

 

 

ВВЕДЕНИЕ 

Все мы любим Excel за скорость и простоту отчетов. Использование Excel для прямого 
управления объектами позволяет исключить затраты связанные с использованием 
посредников, например, ОРС серверов и, при этом, максимально упростить накопление и 
обработку данных. В этой работе даны примеры “выхода” Excel во внешнюю среду через 
СОМ порт, а также показана релейная система термостатирования на базе модуля 
дискретного ввода-вывода ОВЕН МК110, непосредственно управляемая из Excel. 

 

 

ОБЩИЕ СВЕДЕНИЯ 

COM порт 

После+довательный порт (англ. Serial port, COM-порт, англ. Communications port) — 
сленговое название интерфейса стандарта RS-232, которым массово оснащались 
персональные компьютеры. Наиболее часто для последовательного порта персональных 
компьютеров используется стандарт RS-232C. Ранее последовательный порт использовался 
для подключения терминала, позже для модема или мыши. Сейчас он используется для 
соединения с источниками бесперебойного питания, для связи с аппаратными средствами 
разработки встраиваемых вычислительных систем, спутниковыми ресиверами, кассовыми 
аппаратами, а также с приборами систем безопасности объектов. 

С помощью COM-порта можно соединить два компьютера, используя так называемый 
«нуль-модемный кабель». 

Достоинством обмена данными через COM порт является крайняя простота оборудования. 
Недостатком является низкая скорость, крупные размеры разъемов, а также зачастую 



высокие требования к времени отклика ОС и драйвера и высокое количество прерываний 
(одно на половину аппаратной очереди, т.е. 8 байт). 

Связь Excel с COM портом осуществляется через управляющий элемент ActiveX - 
расширенной технологии OLE, призванной существенно увеличить функциональные 
возможности компьютера.  

 
ActiveX 

ActiveX — фреймворк для определения программных компонентов, пригодных к 
использованию из программ, написанных на разных языках программирования. 
Программное обеспечение может собираться из одного или более таких компонентов, 
чтобы использовать их функционал. 

Впервые эта технология была внедрена в 1996 году компанией Microsoft как развитие 
технологий Component Object Model (COM) и Object Linking and Embedding (OLE) и теперь 
она широко используется в операционных системах семейства Microsoft Windows, хотя сама 
технология и не привязана к операционной системе. 

Множество приложений для Microsoft Windows, включая приложения самой компании 
Microsoft, такие, как Internet Explorer, Microsoft Office, Microsoft Visual Studio, Windows 
Media Player, используют управляющие элементы ActiveX, чтобы реализовать набор 
функциональных возможностей и в дополнение инкапсулировать их собственный 
функционал в управляющие элементы ActiveX, чтобы предоставить возможность 
встраивать их в другие приложения. 
 
Элемент ActiveX: MSCOMM32.OCX 

Элемент управления Microsoft Comm Control 6.0 обеспечивает последовательную передачу 
и прием данных через COM порт.  

Во многих ситуациях необходимо получать извещение в тот момент, когда происходит 
событие, такое как 'прибытие' символа или когда происходит изменение в Carrier Detect 
(CD) или Request To Send (RTS-линии). Для перехвата и обработки этих событий 
используется событие OnComm. Событие OnComm также обнаруживает и обрабатывает 
ошибки связи. Каждая управляемая коммуникационная связь использует один 
последовательный порт. Если необходимо обратиться к более чем одному COM – порту 
необходимо использовать больше чем одно средство управления связи.  

Ряд свойств элемента управления Microsoft Comm Control 6.0 представлен в следующей 
таблице: 

Свойство Описание 

CommPort Устанавливает и возвращает номер используемого COM-порта 

Handshaking Устанавливает и возвращает протокол подтверждения связи 

Settings Устанавливает и возвращает скорость в бодах, контроль по четности, 

биты данных, стоповые биты 



PortOpen Устанавливает и возвращает состояние порта связи, а также открывает и 

закрывает COM-порт 

Input Возвращает и удаляет символы из получающего буфера 

InputLen Устанавливает и возвращает число считываемых символов свойством 

Input из буфера 

InBufferCount Возвращает количество символов ждущих в получающем буфере 

InBufferSize Устанавливает и возвращает размер получающего буфера в байтах 

Output Записывает последовательность символов в передающий буфер 

OutBufferCount Возвращает число символов ждущих в передающем буфере 

OutBufferSize Устанавливает и возвращает размер передающего буфера в байтах 

OnComm Событие 
 
Синтаксис свойства CommPort: 

MSComm.CommPort [= portNumber], portNumber можно устанавливать от 1 до 99 (по 
умолчанию portNumber устанавливается равным 1). Если номера COM-порта не существует 
MicrosoftCommControl сгенерирует ошибку 68. Свойство CommPort должно 
устанавливаться перед открытием COM-порта. Тип данных – Integer. 

Синтаксис свойства Settings 

MSComm.Settings[ = paramString], paramString состоит из четырех установок и имеет 
следующий формат – "BBBB, P, D, S" , где:  

BBBB - скорость в бодах  
P - контроль по четности   
D - число битов данных   
S - число стоповых битов  

 
 
Примечание: MSCOMM32.OCX  можно найти и скачать на официальном сайте компании 

Microsoft http://www.microsoft.com/ru-ru/default.aspx. 
 
 
 
 
 
 
 
 
 



ПРИМЕРЫ ПОЛУЧЕНИЯ ПРОВЕРЕННЫХ РЕЗУЛЬТАТОВ И ВАРИАНТЫ ДЛЯ 
САМОКОНТРОЛЯ 
 

Задание 1. Настройка соединения двух компьютеров, через COM порт. 

1. Соедините два компьютера по RS-232 нуль модемным кабелем или, например, через 
MOXA UPort 1150 адаптер как показано ниже. В последнем случае необходимо 
установить драйвер адаптера и настроить его на работу по стандарту RS-232. 

 

2. Запустите программы обмена данными через COM порт, например, программы COM 
Port Toolkit. 

3. Передавая и принимая данные убедитесь, что линия последовательной передачи 
данных работает 

 
Номер COM порта используемого программой устанавливается через меню Toolkit > 
Options > COM port configuration > Port. Показанное окно передачи сообщений Send 
message открывается через меню Toolkit > send. Передаваемые данные отображаются в 
левом окне, а принимаемые данные - в правом окне. Коды отображаются побайтно в 16-
ричном формате. Так, шестнадцатеричный код 36 имеет десятеричный эквивалент 54 
(как 3*16+6), это код цифры 6.  

 

 

 



Задание 2. Обмен данными из среды Excel через COM порт. 

1. Поместите элемент (MSCOMM32.OCX) в папку C:\Windows\System32 

Примечание: Скачать MicrosoftCommControl 6.0 можно с официального сайта компании 
Microsoft http://www.microsoft.com/ru-ru/default.aspx. 

2. Зарегистрируйте MSCOMM32.OCX в командной строке (cmd) командой regsvr32 
MSCOMM32.OCX. 

 

 

3. Подключите MSCOMM32.OCX к Microsoft Excel, для этого откройте вкладку Excel > 
Tools->References через последовательность Excel menu > Tools > Macro > Visual Basic 
Editor > или (<Alt+F11>) и далее > Microsoft Visual Basic menu > Tools > References, в 
открывшемся окне выберите Browse… и, затем, элемент MSCOMM32.OCX из папки 
C:\Windows\System32. 

 

Рис. 1. Окно Referencesпосле с элементом Microsoft Comm Control 6.0 (SP6) 
(MSCOMM32.OCX). 



4. Вставьте форму (<Alt+F11>)  

 

Рис. 2. Вызов формы. 

5. Добавьте в Toolbox элемент MSCOMM32.OCX. Он выглядит как желтый телефон. 

 

Рис. 3. Вставка MSCOMM32.OCX в Toolbox. 

6. Перетащите “телефон” из Toolbox на на форму и оставьте его где-нибудь в углу, при 
работе программы этот элемент отображаться не будет.  

7. Добавьте в форму два окна и одну кнопку, одно окно - для ввода передаваемых данных, 
а второе - для вывода принимаемых данных, редактируя текст кнопки дайте ей 
название. 



 

Рис. 4. Заполнение формы. 

8. Для кнопки формы добавьте код приведённый ниже (для добавления кода, достаточно в 
редакторе дважды щелкнуть на кнопку и откроется окно для ввода кода): 

Листинг кода 
Private Sub CommandButton1_Click() 
    MSComm1.CommPort = 1 
    MSComm1.Settings = "9600,N,8,1" 
    MSComm1.InputLen = 0 
    On Error Resume Next 
    MSComm1.PortOpen = True 
    If Err Then 
MsgBox "Com" & MSComm1.CommPort & ": not available. Change CommPort property to another port." 
    Exit Sub 
    End If 
    MSComm1.Output = TextBox1.Text 
    Do 
    Dummy = DoEvents() 
    Loop Until MSComm1.InBufferCount >= 8 
    TextBox2.Text = MSComm1.Input 
    MSComm1.PortOpen = False 
EndSub 
 
Этот код запускается нажатием кнопки. Он устанавливает связь с COM портом 
пересылает данные верхнего окна формы и дождавшись восьми байт из COM порта 
отображает их в нижнем окне. 
 



 

Рис. 5. Форма, и ее код. Функция CommandButton1_Click(), означает, что код будет 
выполнен при нажатии на кнопку. 

9. Понизьте уровень защиты Excel файла перед запуском макрос: 

 

Рис. 6. Снятие защиты запуска макрос. 



Примечание. Выберите Enable Macros (разрешить макрос) если система спросит об 
этом при при запуске программы Excel с макрос:  

 

10. Соедините два компьютера кабелем для обмена данными через COM порты, если такое 
соединение не установлено. 

11. На втором компьютере (по отношению к компьютеру с Excel формой) запустите 
программу COM Port Toolkit. 

12. На первом компьютере запустите макрос кнопкой Run . 

13. Проверьте работоспособность передачи данных от Excel к COM Port Toolkit. Для этого 
введите данные в верхнее окно формы и нажмите на кнопку формы. COM Port Toolkit 
должен получить эти данные. 

 

Рис. 7. Вид формы и Toolkit после передачи данных. 

Примечание: Если появится сообщение о не возможности работать с COM портом 
выполните следующее. 

• закройте окно предупреждения и форму.  



 

• Узнайте номер подключенного Com порта компьютера: Start > My 
Computer> Properties > Hardware > Device Manager > 

 

• Укажите на форму UserForm1  и раскройте ее код 
клавишей F7 или через меню Microsoft Visual Basic > View > Code. 

• Замените номер порта в коде формы, например, MSComm1.CommPort = 2 

 
Сообщение об ошибке COM порта было сформировано следующими 
строками Macros. 

If Err Then 
MsgBox "Com" & MSComm1.CommPort & ": not available. Change 
CommPort property to another port." 

14. Проверьте передачу данных в обратном направлении от Toolkit в Excel форму. Для 

этого запустите форму  введите данные в Toolkit, нажмите на клавишу send и 
убедитесь, что Excel форма приняла их после нажатия кнопки. Внимание: принятые 
данные в нижнем окне формы появятся только тогда когда их количество достигнет 
уровня указанного в коде: Loop Until MSComm1.InBufferCount >= 8 

 

 

 

 

 

 

 

 



Задание 3. Циклический обмен данными соединения Excel – Toolkit.  

1. Доработайте код кнопки формы как показано ниже. 
Private Sub CommandButton1_Click() 
MSComm1.CommPort = 2 
    MSComm1.Settings = "9600,N,8,1" 
    MSComm1.InputLen = 0 
    On Error Resume Next 
    MSComm1.PortOpen = True 
    If Err Then 
MsgBox "Com" & MSComm1.CommPort & ": not available. Change CommPort property to another port." 
    Exit Sub 
    End If 
    For i = 1 To 4 
      MSComm1.Output = TextBox1.Text 
      Do 
        Dummy = DoEvents() 
      Loop Until MSComm1.InBufferCount >= 2 
      TextBox2.Text = MSComm1.Input 
    Next i 
    MSComm1.PortOpen = False 
End Sub 

2. Проверьте, что после нажатия клавиши формы программа выполняет четыре цикла. На 
каждом цикле сначала отсылаются данные верхнего окна, если, конечно, они там 
имеются, затем Excel ждет в малом цикле поступление двух байт, приняв байты, 
отображает их в нижнем окне формы и, затем, начиная новый цикл передачей данных 
верхнего окна формы в COM порт. 

 

Задание 4. Построение релейной системы термостатирования на базе устройства 
ввода/вывода данных МК110 с накоплением данных и управлением из Excel .  

1. Соберите систему как показано на рисунке ниже.  



 

Рис. 8. Схема соединений системы термостатирования на базе модуля МК110. 

Примечание:  

• Подключение системы к компьютеру через адаптер UPort 1150 показано на 
рисунке задания 1. 

• Датчик температуры установите в зоне нагревателя – лампы. 

• Modbus команды приема/передачи данных модуля MK110: 

RTU_Code Отклик Rx Описание.  

16 16 0 1 0 1 2 3 132 103 66 16 16 0 1 0 1 83 72 Замыкание контактов, выход №2 



16 16 0 1 0 1 2 0 0 103 209 16 16 0 1 0 1 83 72 Размыкание контактов, выход №2 

16 16 0 67 0 1 2 0 0 104 243 16 16 0 67 0 1 243 92 Сброс (предустановка) счетчика 

№4 

16 3 0 67 0 1 118 159 16 3 2 0 0 Чтение счетчика №4 

• В соответствии с modbus протоколом устройство МК110 дает ответ на 
каждую принятую команду в виде последовательности байт.  

• Объект COM порта разделяет нулями байты ответа устройства МК110 
которые считываются из приемного буфера СОМ порта. Это необходимо 
учитывать при выделении нужной информации из ответа устройства. 

2. Драйвер USB адаптера МОХА UPort 1150 настройте на работу по протоколу RS-485 
2W. 

3. Запустите Excel и постройте форму как показано в задании 2 включив в нее следующие 
объекты Toolbox: “телефон”, прокрутку (Scrollbar) и кнопку (CommandButton). 

 

Рис. 9. Пример рабочей формы.  

4. Заполните шаблоны объектов формы следующими VBA кодами. 

 Код кнопки Run:  
Private Declare Sub Sleep Lib "kernel32" (ByVal dwMilliseconds As Long) ‘необходима для задания 

задержки 

Private Sub CommandButton1_Click() 

 

  Dim MyString As String 

  Dim b() As Byte 

 

  For i = 1 To 20    ‘ начало цикла термостатирования 

   ‘ Установка связи c СОМ портом 

    MSComm1.CommPort = 2  ‘ номер СОМ порта 

    MSComm1.Settings = "9600,N,8,1" ‘ скорость передачи СОМ порта и другие параметры 

    MSComm1.InputLen = 0 

    On Error Resume Next 



    MSComm1.PortOpen = True 

    If Err Then   ‘  выводимое сообщение об ошибке открытия СОМ порта: 

      MsgBox "Com" & MSComm1.CommPort & ": not available. Change CommPort property to another port." 

      Exit Sub 

    End If 

 

    'Counter Reset  ‘  ‘ сброс счетчика модуля МК110 по протоколу modbus:: 

    MSComm1.Output = Chr$(16) + Chr$(16) + Chr$(0) + Chr$(67) + Chr$(0) + Chr$(1) + Chr$(2) + Chr$(0) + 

Chr$(0) + Chr$(104) + Chr$(243) 

    Sleep 1000& 'Delay for 1 second      ‘ 1сек пауза для накопления импульсов датчика температуры 

      

    'Counter Read  ‘считывание счетчика модуля МК110 к которому подключен датчик температуры:: 

    MSComm1.Output = Chr$(16) + Chr$(4) + Chr$(0) + Chr$(67) + Chr$(0) + Chr$(1) + Chr$(195) + Chr$(95) 

    Sleep 50& 'Delay for 50 msec   ‘Ожидание (50 мсек) поступления ответа МК110 в буфер СОМ порта 

 

     b = MSComm1.Input  ‘ считывание ответов МК110 на команды “Counter Reset” и “Counter  

    ‘ Read” из входного буфера COM порта (байты ответов разделен нулями), 

    ‘ вычисление значения температуры датчика в градусах С и запись температуры в соответствующую 

    ‘ ячейку таблицы Excel: 

    Sheet1.Cells(i + 6, 2).Value = (b(UBound(b) - 7) * 256 + b(UBound(b) - 5)) / 1.047 - 273.15 

 

    ‘ сравнение температуры датчика с заданной температурой хранимой в ячейке В4: Sheet1.Cells(4, 2)  

    If Sheet1.Cells(i + 6, 2).Value > Sheet1.Cells(4, 2).Value Then 

      ' Lamp OFF     ‘ выключение лампы по протоколу modbus:: 

      MSComm1.Output = Chr$(16) + Chr$(16) + Chr$(0) + Chr$(1) + Chr$(0) + Chr$(1) + Chr$(2) + Chr$(0) + 

Chr$(0) + Chr$(103) + Chr$(209) 

      Sheet1.Cells(i + 6, 3) = "Off" ‘ запись “Off” в соответствующую ячейку Excel 

    Else 

      ' Lamp ON OFF    ‘ включение лампы по протоколу modbus:: 

      MSComm1.Output = Chr$(16) + Chr$(16) + Chr$(0) + Chr$(1) + Chr$(0) + Chr$(1) + Chr$(2) + Chr$(3) + 

Chr$(132) + Chr$(103) + Chr$(66) 

      Sheet1.Cells(i + 6, 3) = "On"  "    ‘ запись “On” в соответствующую ячейку Excel 

    End If 

    MSComm1.PortOpen = False  ‘ отсоединение от COM порта 

  Next I    ‘‘ окончание цикла 

End Sub 

 

 Код прокрутки: 
Private Sub ScrollBar1_Change() 

    ‘запись значения прокрутки как заданной температуры в ячейку B4 Excel 

    Sheet1.Cells(4, 2).Value = ScrollBar1.Value 

End Sub 



5. Подготовьте заголовки таблицы: 

 

6. Запустите макрос формы. 

7. С помощью прокрутки установите заданную температуру отображаемую в ячейке B4. 

8. Запустите термостатирование нажатием кнопки Run формы 

9. Сравните собственный процесс термостатирования с результатом, представленным 
ниже.  

 

Рис. 10. Пример результатов работы системы термостатирования управляемой из Excel 
через COM порт. Excel не только напрямую управляет процессом поддержания заданной 



температуры (здесь 44С) используя макрос, но и накапливает действительные значения 
температуры (ячейки B7:B26) и состояния нагревателя (ячейки С7:C26). 

 

 

 
КОНТРОЛЬНЫЕ ВОПРОСЫ 
 

1. Какие средства необходимы для обеспечения прямого управления из Excel? 

2. От чего зависит частота контура управления через СОМ порт? 
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